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Nrf2 dictates the neuronal survival and differentiation of embryonic
zebrafish harboring compromised alanyl-tRNA synthetase
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ABSTRACT

tRNA synthetase deficiency leads to unfolded protein responses in
neuronal disorders; however, its function in embryonic neurogenesis
remains unclear. This study identified an aars1cq71/cq71 mutant
zebrafish allele that showed increased neuronal apoptosis and
compromised neurogenesis. aars1 transcripts were highly
expressed in primary neural progenitor cells, and their aberration
resulted in protein overloading and activated Perk. nfe2l2b, a paralog
of mammalian Nfe2l2, which encodes Nrf2, is a pivotal executor of
Perk signaling that regulates neuronal phenotypes in aars1cq71/cq71

mutants. Interference of nfe2l2b in nfe2l2bΔ1/Δ1 mutants did not affect
global larval development. However, aars1cq71/cq71;nfe2l2bΔ1/Δ1

mutant embryos exhibited increased neuronal cell survival and
neurogenesis compared with their aars1cq71/cq71 siblings. nfe2l2b
was harnessed by Perk at two levels. Its transcript was regulated by
Chop, an implementer of Perk. It was also phosphorylated by Perk.
Both pathways synergistically assured the nuclear functions of
nfe2l2b to control cell survival by targeting p53. Our study extends
the understanding of tRNA synthetase in neurogenesis and implies
that Nrf2 is a cue to mitigate neurodegenerative pathogenesis.

KEYWORDS: Aars1, Nrf2, UPR, Perk, Neuronal apoptosis, Zebrafish

INTRODUCTION
The sophisticated synthesis and precise modification of nascent
proteins are tightly regulated by a set of intracellular structures,
particularly the endoplasmic reticulum (ER) (Pobre et al., 2019).
Errors in protein synthesis and protein folding usually lead to ER
stress and unfolded protein response (UPR) (Walter and Ron, 2011).
When the UPR is mild and can be handled properly, adaptive
degradation of the misfolded protein is promoted by active spliced
X-box-binding protein 1 (XBP1), which is mainly produced by
the transautophosphorylated iron-responsive element 1α (IRE)
(Grandjean et al., 2020). In parallel, the ATF6 axis is involved in the
attenuation of the UPR to promote cell survival (Yu et al., 2017).

When intensive and/or chronic stress is overloaded, cell apoptosis
occurs via induction of PERK (EIF2AK3) through its
oligomerization and the phosphorylation of multiple targets, in
particular EIF2A, to inhibit a general panel of proteins (Wang and
Kaufman, 2016). ATF4 selectively activates the cell apoptosis
program through cooperation with its target, CHOP (DDIT3) (Hu
et al., 2018). The three branches of the UPR pathway coordinately
determine the cell conditions (Binet and Sapieha, 2015).

The transcription factor NRF2 is encoded by the nuclear factor
erythroid-derived 2-like 2 gene (NFE2L2). It has been proposed to
be a master regulator of external stresses to promote cell survival
(Baumel-Alterzon et al., 2021). However, multiple functions of
NRF2 have recently been reported. Phosphorylated NRF2 has been
linked to PERK in the immunosuppression of tumors (Mohamed
et al., 2020). The activation of nfe2l2a, a zebrafish paralog of
Nfe2l2, attenuates ER stress in pmm2-deficient larval livers
(Mukaigasa et al., 2018). Several studies have reported that
activated NRF2 serves as a substrate for caspase-3 (-like)
proteases and functions together with P38 or P53 (TP53) to
induce apoptotic processes (Bonay et al., 2015; Ohtsubo et al.,
1999). The various outcomes of NRF2 indicate its complicated and
context-dependent effects (Menegon et al., 2016).

The AARS1 gene encodes alanyl-tRNA synthetase (AlaRS),
which is composed of three domains: an N-terminal aminoacylation
domain, an editing domain and a C-terminal domain. It conducts a
conserved aminoacylation reaction to charge alanine amino acids on
the corresponding cognate tRNAs. This process is essential for the
translation of the genetic code in protein or peptide synthesis. In the
Aars1sti/sti mutant mice that harbored a C-to-A mutation at amino
acid 734 in the editing domain of aminoacyl-tRNA synthetase
(Aars1), notable loss of Purkinje cells and the development of
neurodegenerative-like syndromes were observed (Lee et al., 2006).
This phenotypewas caused by the production of serine-mischarged-
tRNAAla, which led to UPR in the cerebellar Purkinje cells.
Ankrd16, a vertebrate-specific protein containing ankyrin repeats,
partially alleviated the degeneration of cerebellar Purkinje cells in
Aars1sti/stimutant mice by binding to the catalytic domain of AlaRS
to capture the misactivated serine and prevent mischarging
(Vo et al., 2018). In humans, 11 missense mutations in three
functional domains of AARS1 have been identified in Charcot-
Marie-Tooth type 2N, an autosomal-dominant inherited form of
axonal neuropathy (McLaughlin et al., 2012; Motley et al., 2015;
Simons et al., 2015). These phenomena indicate the indispensable
role of AARS1 in the control of proteostasis and UPR intensity in
neuronal development and neurodegenerative diseases.

Neurogenesis in zebrafish is initiated by the specification of
neural progenitor cells (NPCs) after the establishment of the
neuroectoderm (Schmidt et al., 2013). Deficiency in the production
and maintenance of NPCs leads to compromised neurogenesis
(Li et al., 2020). In the present study, we performed a large-scale
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mutant screening and identified an aars1cq71/cq71 mutant zebrafish
allele that manifested compromised neurogenesis caused by
intensive cell apoptosis of NPCs. Together with the threonyl-
tRNA synthetase mutant, tars1cq16/cq16 (Cao et al., 2016), we
revealed that compromised aminoacyl-tRNA synthetase in the NPCs
led to UPR reactions and resultant cell apoptosis by the activation of
Perk signaling. nfe2l2b, but not nfe2l2a, acted as a downstream
executor by targeting p53. Our study reveals Nrf2 as a regulative
molecule of p53 in Perk-mediated cell apoptosis and provides clues
on the progress and treatment of neurodegenerative disorders.

RESULTS
Identification of an ethylnitrosourea (ENU) mutant with
compromised neurogenesis
To explore the molecules involved in neurogenesis, we performed
an unbiased large-scale screening of a candidate pool of
ethylnitrosourea (ENU)-induced mutagenesis (Cao et al., 2016).
We examined the signals of neurogenic differentiation 1 (neurod1),
which is mainly expressed in postmitotic neuronal cells, by whole-

mount in situ RNA hybridization (WISH). The recessive ENU
mutant allele that presented an obvious reduction in neurod1+

signals was fortuitously recovered (Fig. 1A). We named it as
‘Chongqing number 71’ (cq71) mutant (referred to as Mutcq71/cq71

herein). Several genes that encode components of neuronal and glial
cells were further analyzed in Mutcq71/cq71 by characterizing either
corresponsive reporter lines or transcript levels. The signals of
neural-specific beta-tubulin (NBT) in pan-neuronal cells, sox2 and
neurog1 in NPCs, Elav-like neuron-specific RNA-binding protein 3
(HuC) and NGF/microtube-associated protein2 (map2) in young
neurons, alpha-tubulin ortholog (tuba1b) in mature neurons, olig2
in eurydendroid neurons in the cerebellum, and glial fibrillary
acidic protein (gfap) in astrocytes and radial glial cells showed
marked reduction in the brains, but not spinal cords, of Mutcq71/cq71

compared with their wild-type (WT) and heterozygous siblings at
2.5-3 dpf (Fig. 1A, Fig. S1A,B). The size of 3 dpf midbrain was
75,973±2162 μm2 in Mutcq71/cq71 larvae compared with
91,176±2063 μm2 in WT counterparts (Fig. S1C). Mutcq71/cq71

larvae did not survive beyond 7 dpf (Fig. S1D). The behavior

Fig. 1. Phenotype characterization of Mutcq71/cq71 embryos. (A) Whole-mount in situ RNA hybridization (WISH) and fluorescent images of 3 dpf larval
brain. The white and black arrowheads indicate the fluorescence and WISH signals, respectively. (B) Representative movement traces of 3 dpf larvae.
(C) Timelapse frames of Ca2+ sparks in the midbrains of Tg(HuC:GCaMP6s). The red and white circles indicate the active (red) and dead (white) neurons
with Ca2+ transients or intensive Ca2+ signals, respectively. (D) Immunofluorescent images of TUNEL and Sox2 in the transverse sections of 3 dpf midbrains.
The white arrowheads indicate the colocalization of TUNEL+ and Sox2+ signals. (E,F) Representative immunofluorescent images (E) and quantification (F) of
Caspase-3+ signals in 3 dpf midbrains (highlighted by white dashed lines) (mean±s.e.m.; sibling, 18.24±0.71 n=17; Mutcq71/cq71, 63.41±3.51 n=21; two
independent clutches; unpaired two-tailed Student’s t-test). (G) Schematic illustration of increased neural progenitor cell (NPC) apoptosis and compromised
neurogenesis in Mutcq71/cq71 brains. Scale bars: 20 µm.
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recordings indicated that 3 dpf WT larvae spontaneously moved at
0.19±0.05 cm/s to cover a distance of 81.74±20.34 cm during a
5 min recording. However, Mutcq71/cq71 larvae exhibited
compromised spontaneous mobility (Fig. 1B, Fig. S1E,F,
Movie 1). The WT larvae rapidly responded to the external
stimuli of either needle-touch or light reduction and altered the
speed to 0.22±0.02 cm/s or 0.15±0.02 cm/s, respectively. However,
the Mutcq71/cq71 larvae remained mostly frozen (Fig. S1G-L,
Movies 2 and 3). Although Mutcq71/cq71 larvae occasionally acted
upon the stimuli, their movement speeds were markedly reduced
compared with those of their WT siblings (Fig. S1I,L).
Accordingly, neuronal activities indicated by Ca2+ transients of
various types were frequently detected in WT transgenic Tg(HuC:
GCaMP6s) midbrains; however, they were barely seen in the
Mutcq71/cq71 Tg(HuC:GCaMP6s) (Fig. 1C, Movie 4). These
phenotypes indicated compromised neurogenesis in Mutcq71/cq71

embryos, suggesting increased cell death and/or reduced
proliferation of NPCs in this scenario. The staining results
indicated that phospho-Histone 3 (PH3+) signals surprisingly
displayed an increment in Mutcq71/cq71 brains at 2.5 dpf
(Fig. S1M,N). However, the terminal deoxynucleotidyl transferase
dUTP nick end labeling (TUNEL)+ signals that were rarely detected
in Sox2+ NPCs in WT larvae were easily visible in Mutcq71/cq71

counterparts (Fig. 1D). Simultaneously, Acridine Orange (AO) and
Caspase-3 signals increased notably in the Mutcq71/cq71 brains, but
not in the spinal cord, when compared with those in their WT and
heterozygous siblings (Fig. 1E,F, Fig. S1O-S). The expanded
AO+ signals were collected but not effectively cleared by Coro1a-
Dsred+ microglia (Li et al., 2012) and exhibited enlarged foci
in the Mutcq71/cq71 brains (Fig. S1S). These results indicated
increased apoptosis of NPCs and compromised neurogenesis in the
Mutcq71/cq71 brains (Fig. 1G).

aars1 intrinsically regulates neuronal survival and
neurogenesis
To unveil the gene responsible for Mutcq71/cq71mutants, we utilized a
total of 1890 meioses to perform genetic linkage analysis and
restricted the location to chromosome 18, with ∼1.35 and 0.92
centimorgan intervals to ZK225B14 and ZK261F4, respectively
(Fig. 2A). One recombination was discovered by sequencing
the selected single-nucleotide polymorphism (SNP) 1 and 2 in
this region, further narrowing the mutation to a 0.13 Mb
spacing (Fig. 2A). Four genes were annotated in this fragment
according to the information from Ensembl (http://asia.ensembl.org/
index.html). A point mutation (T-to-A) in exon 5 of aars1 was
identified in the Mutcq71/cq71 embryos (Fig. 2B, Fig. S2A).
There are four isoforms of aars1 in zebrafish. However, only
201 (ENSDART00000076695.6), a short isoform, and 202
(ENSDART00000100401.6), encoding the whole functional
domain of aars1, were successfully amplified from the cDNA
library of 3 dpf embryos. The T-to-A mutation in aars1cq71/cq71

caused an alteration from UGU to UGA at position 171, producing a
truncated protein with a premature stop codon (Fig. 2B, Fig. S2B).
Western blot analysis indicated that the mutant forms of HA-aars1
were unstable, and the protein levels of Aars1 were markedly reduced
by 87%, in the aars1cq71/cq71 brains compared with the brains of their
WT siblings (P=0.0002) (Fig. 2C, Fig. S2C). Furthermore, WISH
showed a dramatic reduction in aars1 transcripts in the aars1cq71/cq71

mutants comparedwith theWT siblings (Fig. S2N). The transcription
levels of the nonsense-mediated mRNA decay (NMD)-related genes,
including upf1 and upf3b, but not upf3a, were significantly increased
in aars1cq71/cq71 mutants (Fig. S2D), implying an NMD

(Cheruiyot et al., 2021) promoting rapid degradation of aars1
mRNA in aars1cq71/cq71 mutants. These data indicated that the
aars1cq71/cq71 mutant was a null allele.

The zebrafish full-length Aars1 (Aars1202) protein shared 81.88%
and 82.61% similarity with its human and mouse counterparts,
respectively (Fig. S2E). Supplementation of aars1202 (referred to as
aars1 in subsequent sections) and even human AARS1 in the
aars1cq71/cq71 mutant embryos rescued the phenotypes of Sox2+

NPCs and reduced the TUNEL+ and AO+ signals (Fig. 2D,
Fig. S2F,G). An additional aars1Δ10/Δ10 mutant allele with a 10 bp
deletion was generated. The aars1Δ10/Δ10 mutation caused
premature termination of the Aars1 protein in the amino acid
activation domain (Fig. 2B, Fig. S2A), which led to a dramatic
reduction in its protein levels to 15% of that in siblings (Fig. 2C,
Fig. S2C). Similar to the aars1cq71/cq71 mutant embryos, the
aars1Δ10/Δ10 mutants manifested intensive atrophy of the midbrain,
an increase in AO+ signals, and a reduction in Sox2+, HuC+ and
neurod1+ pools compared with their WT siblings (Fig. 2E,F,
Fig. S2H). The result of a complementary assay by mating aars1cq71/
cq71 with aars1Δ10/Δ10 allele indicated the same declined aars1
transcripts and neural-defective signatures as those seen in either
aars1cq71/cq71 or aars1Δ10/Δ10 mutant alleles (Fig. S2I-K).
Interference of aars1 using ribonucleoproteins (RNPs) (Cas9
protein/synthetic crRNA:tracrRNA duplex technology) (Kroll
et al., 2021) was further investigated. Among the six predicted
target sites by Integrated DNA Technologies (IDT), three targets of
crRNAs at loci A, B and D showed the highest mutated efficiency of
94%, 90% and 65%, respectively, according to the ratio of head
loop-PCR/standard-PCR (Kroll et al., 2021) (Fig. S2L). The levels
of Aars1 protein were reduced by 77% in the aars1 F0 group after
the combinational application of these crRNAs compared with
those in the controls (P=0.0016) (Fig. S2M). Annexin V staining
was applied as an indicator, because it has a high affinity for
phosphatidylserine of dying cells (Balaji et al., 2013). A marked
increase in Annexin V+ signals was detected in aars1 F0 embryos
treated with aars1 RNPs compared with controls (Fig. 2G),
corroborating the increased neuronal apoptosis and compromised
neurogenesis upon Aars1 deficiency.

The aars1 transcript appeared even at the one-cell stage of the
fertilized embryos and was almost evenly present in the cells at the
50% epiboly stage (Fig. S2N). Following this, the transcript was
highly expressed in the midbrain and digestive organs (Fig. S2O). In
the midbrain, double staining and quantitative PCR (qPCR) results
indicated that the aars1 transcript was highly detected in the sox2+,
NBT+ and HuC+ cells, detected to a lower extent in the neurod1+

and olig2+ cells, and was limited in the coro1a+ microglial cells
(Fig. 2H, Fig. S2P), implying its enrichment in NPCs and
intrinsically regulated neurogenesis. Therefore, we provided aars1
in the pan-neuronal cells by fusing its cDNA sequence to the NBT
promoter (Thomas-Jinu et al., 2017). This assay could supply aars1
in Sox2+ NPCs, based on the clear detection of Sox2+ signals in the
NBT-DenNTR+ cells (Fig. S2Q). Continual supplementation of
NBT-aars1 in Tg(NBT:aars1) slightly lowered the AO+ signals
but markedly mitigated the intensity of AO+ phenotypes in
aars1cq71/cq71 mutants to a level comparable with that in WT
siblings (Fig. 2I,J). Furthermore, a transplantation assay was
performed following previous instruction (Zou and Wei, 2010).
An equal number of cells (30-50) was isolated from the blastomeres
of WT or aars1 F0 animals harboring NBT-DenNTR background.
These cells were transplanted into the recipients (Fig. 2K).
Examination of Annexin V indicated that the signals did not
present notable alterations in the aars1cq71/cq71 mutant recipients
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Fig. 2. aars1 intrinsically regulates neural survival and neurogenesis. (A) Schedules of the bulk segregation and fine-mapping strategies in identifying
mutant genes. (B) Diagram of two types of aars1 mutant alleles. The gray box shows 10 bp deletion at exon 4 of aars1Δ10/Δ10; the orange box indicates an
alteration of T to A at exon 5 of aars1cq71/cq71. All these mutants led to the early termination of Aars1 protein. (C) Western blot of Aars1. The protein levels of
Aars1 reduced by 87% (P=0.0002) and 85% (P=0.0001) in the aars1cq71/cq71 and aars1Δ10/Δ10 mutants, respectively, compared with those in their siblings.
(D) Immunofluorescent images of Sox2 in the midbrains of siblings and aars1cq71/cq71 after injecting H-AARS1 mRNA. The white arrowheads indicate the
Sox2+ signals. (E) Immunofluorescent (left and middle column) and WISH (right column) images of Sox2 (white arrowheads, left column), GFP (white
arrowheads, middle column) and neurod1 (black arrowheads). (F,G) Fluorescent images of Acridine Orange (AO)+ (F) and Annexin V+ (G) signals in the
midbrains. (H) Immunofluorescent images of double staining of aars1 transcript with Sox2. (I,J) Representative fluorescent images (I) and quantification (J) of
AO+ signals in the midbrains [mean±s.e.m.; control: sibling, 4.07±0.22 n=7; aars1cq71/cq71, 11.01±0.76 n=6; Tg(NBT:aars1): sibling, 2.57±0.18 n=17;
aars1cq71/cq71, 5.39±0.49 n=15; two independent clutches; two-way ANOVA]. (K) Schema for the transplantation experiment. (L) Confocal imaging of NBT-
DenNTR+ and Annexin V+ signals at 3 dpf. The arrowheads indicate the NBT-DenNTR+ and Annexin V+ signals. (M) The percentage of Annexin V+ signals
in the NBT-DenNTR+ cells in L (mean±s.e.m.; WT donor: sibling, 3.22±0.70 n=30; aars1cq71/cq71, 0.93±0.38 n=23; aars1 F0 donor: sibling, 23.59±2.98 n=19;
aars1cq71/cq71, 33.72±4.59 n=18; two independent clutches; two-way ANOVA). Scale bars: 20 µm.

4

RESEARCH ARTICLE Development (2022) 149, dev200342. doi:10.1242/dev.200342

D
E
V
E
LO

P
M

E
N
T



after accepting the NBT+ blastomere cells from theWT siblings, but
were elevated dramatically after receiving the donors of the aars1
F0 origin compared with their control groups (Fig. 2L,M). Taken
together, these results indicate that aars1 is cell-autonomously
required and functionally conserved for neuronal survival and
development.

ER stress and UPR are elevated to induce NPC apoptosis in
aars1cq71/cq71 mutants
The molecular mechanisms underpinning aars1 in neurogenesis
require further investigation. To this end, single-cell RNA
sequencing (scRNA-seq) was performed (Fig. S3A). In total,
17,519 and 14,465 cells were obtained from 2 dpf siblings and
aars1cq71/cq71 mutant midbrains, respectively. Comparable
sequencing depths (18,129 and 22,921 reads/cell), median unique
molecular identifier (UMI) counts (1964 and 2844 UMI/cell), and
median gene numbers (949 and 1211 genes/cell) were obtained

from WT siblings and aars1cq71/cq71 mutants. We classified the cell
types of all samples and mapped the resulting reads to the zebrafish
genome for unbiased clustering using Seurat software. Twelve
major cell clusters were identified (Fig. S3B). Among them, nine
neuronal clusters [GABAergic neurons, glutamatergic neurons,
thalamic neurons, progenitor neurons (differentiating), progenitors,
radial glial cells (RGCs), optic tectum neurons, vagal neurons and
oligodendrocyte progenitor cells (OPCs)], based on the top ten
genes in each cluster, were predominant (Fig. 3A-C). Intriguingly,
cluster 4 progenitor cells were notably enlarged to 65% in the
aars1cq71/cq71 mutants, in contrast to the detectable shrinkage of
other clusters (Fig. 3D). Evaluation of 20 aminoacyl-tRNA
synthetases (ARSs) revealed that aars1 transcripts were singularly
enriched in cluster 4 (Fig. 3E, Fig. S3C). Cluster 4 was further
divided into three subtypes, and aars1 was more precisely
positioned in subpopulations 1 and 2, the oldest stages of the
progenitors that occupied more than half of this pool (Fig. 3E-G).

Fig. 3. Profiles of neural cell clusters in WT and aars1cq71/cq71 mutants. (A) Graph-based clustering of neural cells. RGCs, radial glial cells; OPCs,
oligodendrocyte progenitor cells. (B) t-SNE plot of the integration of neural cell clusters. (C) Heat map of the top ten transcript levels. (D) The cell proportions
of distinct clusters in siblings and aars1cq71/cq71 mutants. (E) Violin plot of aars1 expression in neural cell (top) and progenitor cell (PC) (bottom) clusters
in F. (F) t-SNE plot of PC clusters in siblings. (G) PC cluster trajectories of pseudotime by Monocle; colors depict the cell clusters in F. The arrows and
numbers represent pseudotime and the decision point of progenitor cells, respectively. (H) Kyoto Encyclopedia of Genes and Genomes (KEGG) pathway
term of upregulated genes in aars1cq71/cq71 PCs. (I) Gene set enrichment analysis (GSEA) enrichment plot of upregulated pathways (apoptosis, unfolded
protein response) in aars1cq71/cq71 mutants. (J) Western blot results of protein ubiquitylation in brain lysates after injecting FLAG-tagged ubiquitin plasmid.
The ubiquitylation levels increased by 30% in the aars1cq71/cq71 mutants compared with those in siblings (P=0.0021). (K) Quantification of AO+ signals
[mean±s.e.m.; control: sibling, 0.67±0.13 n=7; aars1cq71/cq71, 7.58±0.60 n=6; cycloheximide (CHX): sibling, 2.64±0.26 n=8; aars1cq71/cq71, 4.81±0.21 n=8;
two independent clutches; two-way ANOVA]. (L) Immunofluorescent images of Sox2+ cells. White arrowheads indicate the Sox2+ signals. (M) Schematic
illustration of unfolded protein response leading to NPC apoptosis in aars1cq71/cq71 mutants. Scale bar: 20 µm.
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These data were consistent with the intrinsic roles of aars1 in the
survival of NPCs and suggested the stalling of progenitor
differentiation before apoptosis in the aars1cq71/cq71 mutants.
Information regarding the Kyoto Encyclopedia of Genes and
Genomes (KEGG) pathway from cluster 4 revealed pronounced
elevations in aminoacyl-tRNA biosynthesis signaling, necroptosis
and protein processing in the ER (Fig. 3H). Gene Ontology (GO)
analysis indicated a marked alteration of factors in the UPR and
apoptotic pathways (Fig. 3I, Fig. S3D), pointing to protein overload
and ER stress in the NPCs of the aars1cq71/cq71mutants. To this end,
we injected FLAG-tagged ubiquitin constructs into WT siblings
and aars1cq71/cq71 mutant embryos, which were then detected using
anti-FLAG antibodies. The levels of ubiquitin-modified protein
fragments were increased by 30% in the administered aars1cq71/cq71

mutant embryos compared with those in the WT siblings
(P=0.0021) (Fig. 3J). However, when the protein loads were
attenuated by cycloheximide (actidione, naramycin A; CHX),
an antifungal antibiotic that inhibits protein and RNA synthesis
(Klinge et al., 2011), the AO+ and Sox2+ cells in the aars1cq71/cq71

mutants recovered to the levels in the WT siblings (Fig. 3K,L).
These results indicated that the intensive UPR by misfolded
proteins induced NPC apoptosis in aars1cq71/cq71 mutants
(Fig. 3M).

Perk signaling is responsible for NPC apoptosis in
aars1cq71/cq71 mutants
Protein overload causes ER stress. A prolonged UPR eventually
leads to apoptosis (Guha et al., 2017). Indeed, the protein levels of
BiP (Hspa5), a protein-folding chaperone (Wang et al., 2017),
increased by 117% in the aars1cq71/cq71 mutant brains compared
with those in the brains of their WT siblings (P=0.0004) (Fig. 4A,
Fig. S4A). The ER structures were severely distended and dilated in
aars1cq71/cq71 mutant brains compared with those in WT sibling
brains (Fig. 4B, Fig. S4B). To determine the role of aggravated ER
stress in excessive apoptosis of aars1cq71/cq71 mutant NPCs, two
chemicals, thapsigargin (Tg), a potent ER Ca2+ pump inhibitor
(Sehgal et al., 2017), and tunicamycin (Tn), a protein glycosylation
inhibitor (Guha et al., 2017), were used to treat WT embryos. The

Fig. 4. Perk signaling controls neuronal apoptosis in aars1cq71/cq71 mutants. (A) Western blot of Bip. Bip protein levels increased by 117% in the
aars1cq71/cq71 mutants compared with those in siblings (P=0.0004). (B) Endoplasmic reticulum structure by transmission electron microscopy. N, nucleus;
ER, endoplasmic reticulum (red arrows); Mt, mitochondria. (C) Fluorescent images of AO+ signals in the midbrains of WT embryos treated with thapsigargin
(Tg) from 36 to 53 hpf (left column) or tunicamycin (Tn) from 2.5 to 3 dpf (right column). DMSO, dimethyl sulfoxide. (D,E) Representative fluorescent images
(D) and quantification (E) of AO+ signals in the midbrains (mean±s.e.m.; control: sibling, 0.53±0.06 n=16; aars1cq71/cq71, 7.20±1.32 n=12; azoramide: sibling,
0.39±0.03 n=18; aars1cq71/cq71, 1.97±0.46 n=14; two independent clutches; two-way ANOVA). (F) Western blot of p-eIF2α and eIF2α. The levels of p-eIF2α
increased by 48% (P=0.0058) and 199% (P=0.0008) in the aars1cq71/cq71 (left) and aars1Δ10/Δ10 (right) mutants, respectively, compared with those in their
siblings. (G) Quantification of AO+ signals after treatment with GSK2656157 (mean±s.e.m.; control: sibling, 1.73±0.18 n=12; aars1cq71/cq71, 7.66±0.65 n=10;
GSK2657157: sibling, 0.97±0.05 n=12; aars1cq71/cq71, 2.83±0.44 n=7; two independent clutches; two-way ANOVA). (H,I) Fluorescent images of AO+ signals
after injecting chop mRNA (H) or ribonucleoprotein (I). (J) Quantification of midbrain size (mean±s.e.m.; control: sibling, 86,414.22±876.09 n=14;
aars1cq71/cq71, 64,523.13±1402.89 n=9; chop F0: sibling, 83,041.39±889.31 n=12; aars1cq71/cq71, 75,772.63±1359.52 n=21; two independent clutches;
two-way ANOVA). (K) Schematic illustration of endoplasmic reticulum stress inducing NPC apoptosis through the Perk–Chop axis in aars1cq71/cq71 mutants.
Scale bars: 0.5 µm (B); 20 µm (C,D,H,I).
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application of either molecule promoted the appearance of
substantial AO+ signals in the brains of cultured embryos
(Fig. 4C). Conversely, significant mitigation of AO+ phenotypes
was observed when aars1cq71/cq71 mutant embryos were incubated
with azoramide, an ER stress inhibitor (Fu et al., 2015) (Fig. 4D,E).
In mammalian cells, ER stressors activate proximal UPR

pathways through three major trans-ER membrane proteins, IRE1,
ATF6 and PERK (Metcalf et al., 2020). We investigated the kinetics
of these pathways by measuring the protein volume of
phosphorylated (p)-eIF2α (as a direct readout of Perk activation)
(Humeau et al., 2020), and the transcript amounts of atf6 and
‘unconventional’ splicing of xbp1 (reflecting Ire1 activation) (Guo
et al., 2014) in the pooled WT sibling or aars1cq71/cq71 mutant
embryos. The protein levels of eIF2α, especially its activated form,
p-eIF2α, were markedly elevated by 48% in the aars1cq71/cq71

mutant brains compared with those in the brains of their WT
siblings (P=0.0058) (Fig. 4F), indicating the activation of Perk
signaling upon aberrant aars1 function. Although the transcript
levels of atf6 and ire1α were notably increased in aars1cq71/cq71

mutants (Fig. S4C), neither pathway was effectively functional,
based on the results of the defective xbp1 RNA splicing and the
inability of the ATF6 inhibitor Ceapin A7 (Gallagher et al., 2016) to
attenuate cell apoptosis in the aars1cq71/cq71 mutants (Fig. S4D,E).
To further assess the effects of Perk signaling, we interfered with
Perk function by using GSK2656157, a specific Perk signaling
inhibitor (Atkins et al., 2013), which decreased the p-eIF2α protein
levels by 64% compared with the controls (P=0.0030) (Fig. S4F).
Application of this chemical remarkably reduced the AO+ signals in
the aars1cq71/cq71 mutant midbrains, which were not present in the
samples that were treated with controls (Fig. 4G). Collectively, Perk
activation during ER stress plays a crucial role in NPC apoptosis in
aars1-deficient embryos. Atf4 and the pro-apoptotic transcription
factor chop are responsible for Perk and eIF2α activity (Walter
and Ron, 2011). Their expression levels increased markedly in
aars1cq71/cq71 mutant brains compared with those in the brains
of their sibling counterparts (Fig. S4A,G). Additionally,
overexpressing chop mRNA in WT embryos markedly induced
the appearance of AO+ signals (Fig. 4H). Conversely, injection of
the designed chop RNPs, which efficiently mutated the F0 embryos
by more than 70% in each target locus, significantly reduced the
AO+ signals in aars1cq71/cq71 mutants compared with those in WT
embryos (Fig. 4I, Fig. S4H,I). An enlarged pool of NBT-DenNTR+

cells and increased sizes of the midbrain in the RNP-treated
embryos were observed simultaneously (Fig. 4J, Fig. S4J).
Autophagy has been reported to be regulated by Perk in zebrafish
(Jia et al., 2015), and it is involved in tRNA synthetase-deficient
cardioproteinopathy (Liu et al., 2014). However, examination of the
protein levels of microtubule-associated protein light chain 3 (Lc3;
Map1lc3b) and p62 by western blotting, together with the imaging
of mCherry-Lc3-labeled autophagosomes and p62-characterized
autophagy substrates in the neurons, indicated that their signals were
limitedly altered in the aars1cq71/cq71mutants compared with those in
the WT siblings (Fig. S4K-M). Collectively, these results indicated
that activated Perk signaling in the aars1cq71/cq71 mutants triggered
NPC apoptosis via chop (Fig. 4K) but limitedly affected autophagy.

nfe2l2b as a key executor of the Perk pathway in the
regulation of neuronal fate
The mechanism by which the PERK–CHOP axis regulates cell
survival remains unclear. To address this, we established an in vitro
cell culture assay to explore the key factors involved. The addition
of Tn and Tg to HEK293T cells successfully induced an increase in

annexin V+ signals (Fig. 5A,B). In the groups treated with Tg and
Tn, the levels of p-PERK elevated to 398% (P<0.0001) and 353%
(P<0.0001), respectively, compared with the controls (Fig. 5A-C).
We then focused on NRF2, a classical antioxidant transcription
factor that plays a vital role in a wide spectrum of stress responses
(Ma, 2013). Western blotting results indicated that the protein levels
of NRF2 significantly elevated by 210% (P<0.0001) and 67%
(P=0.0018) in the Tg and Tn groups, respectively, compared with
the controls (Fig. 5D). Immunostaining data revealed a similarly
notable increase, especially its phosphorylated form in the nucleus,
upon application of these chemicals (Fig. 5D,E). Concordantly,
treating HEK293T cell lines and WT zebrafish embryos with
oltipraz, an Nrf2-specific activator (Magesh et al., 2012),
exacerbated Annexin V+ and AO+ signals but reduced p-eIF2α
protein levels by 32% relative to those in the control (P=0.0017)
(Fig. 5F,G, Fig. S5A). There are two Nfe2l2 paralogs in zebrafish,
nfe2l2a and nfe2l2b (Fig. S5B). Pattern characterization using
WISH indicated that both factors were maternally expressed
(Fig. S5C). They were similarly detected in the brain and eyes
and colocalized with NBT-DenNTR+ cells (Fig. 5H, Fig. S5C).
Interestingly, qPCR and fluorescence in situ hybridization (FISH)
results indicated that the transcript levels of nfe2l2b were increased
by 2.7-fold in aars1cq71/cq71 NBT+ cells (Fig. 5H,I, Fig. S5D), in
contrast to the reduced levels of nfe2l2a at the same time (Fig. S5D).
Activation of nfe2l2a has been reported to attenuate ER stress in
pmm2-deficient larval livers (Mukaigasa et al., 2018); however, the
functions of nfe2l2b, a paralog of Nfe2l2, have rarely been
investigated. Delivery of exogenous chop mRNA and oltipraz
significantly elevated the transcript levels of nfe2l2b, but showed
reduced influence on nfe2l2a transcript levels (Fig. 5J, Fig. S5E).
The application of chop RNPs led to opposite outcomes (Fig. 5K).
Supplying nfe2l2a to the aars1cq71/cq71 mutants showed limited
effects on the mitigation of AO+ and Sox2+ signals (Fig. S5F,G).
These data suggest that nfe2l2b functions downstream of the
Perk–Chop axis in the regulation of neuronal apoptosis. Therefore,
we injected one-cell embryos with nfe2l2b mRNA and performed
AO staining. Surprisingly, overexpression of full-length nfe2l2b
mRNA significantly increased AO+ signals in WT midbrains but
reduced the p-eIF2α protein levels by 26% (P=0.2332) (Fig. 5L,
Fig. S5H). Conversely, we generated a nfe2l2b mutant allele with a
1 bp deletion, which led to a predictive premature stop codon in
translation (Fig. S5I). The protein levels of HA-tagged-Nfe2l2bΔ1/Δ1

were reduced by 96% compared with those in Nfe2l2bwt (P<0.0001)
(Fig. S5J). Homozygous nfe2l2bΔ1/Δ1mutants survived to adulthood,
with no general difference in appearance compared with their WT
siblings (Fig. 5M). However, compensatory disruption of nfe2l2b
through the generation of aars1cq71/cq71;nfe2l2bΔ1/Δ1 mutant larvae
attenuated the phenotypes of increased TUNEL+ signals and brain
atrophy in the aars1cq71/cq71 mutants (Fig. 5N,O). Intriguingly,
the phenotypes of the neural populations, reflected by Sox2+,
neurod1+ and even oligo2+ cells, were significantly recovered in the
aars1cq71/cq71;nfe2l2bΔ1/Δ1 mutants to the levels in either the WT
siblings or nfe2l2bΔ1/Δ1 embryos (Fig. 5P-R). Taken together, these
results indicate that Nfe2l2b serves as a sufficient downstream player
of Perk signaling via transcript control by Chop and activity
manipulation by Perk to regulate NPC survival and neurogenesis in
embryonic zebrafish (Fig. 5S).

p53 isadirect targetofNfe2l2b inmasteringneuronal survival
NRF2 is a transcription factor (Fernández-Millán et al., 2016), the
targets of which we dissected. p53was selected as a candidate based
on the predicted Nrf2-binding site (GTAACAAAG) in its promoter
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sequence element (Fig. 6A). Chromatin immunoprecipitation
(ChIP) and luciferase assays were then performed. The ChIP
results indicated that Nfe2l2b is bound to the element
(GTAACAAAG) located at the −639 site of the p53 promoter
in vivo (Fig. 6B). Luciferase activity increased ∼3.5-fold after
addition of the vectors harboring this element compared with the
control (Fig. 6C). However, mutating this coding sequence (CDS)
caused an obvious reduction in luciferase activity by ∼2-fold
(Fig. 6C). Meanwhile, the WISH results showed that the p53+

signals were markedly decreased in the nfe2l2bΔ1/Δ1 mutant brains,
but significantly increased upon nfe2l2b mRNA injection
(Fig. 6D,E). Overexpression of nfe2l2b mRNA in Tg(NBT:
DenNTR) embryos followed by triple fluorescent labeling
revealed that p53+ signals were ectopically detected in NBT-
DenNTR+ cells, which colocalized with nfe2l2b and displayed
TUNEL+ signals (Fig. 6F,G). Additionally, P53 protein levels
increased markedly in cultured HEK293T cells treated with Tg in a

dose-dependent manner (Fig. S6A). Similarly, the p53 transcript
levels were significantly increased in NBT-DenNTR+ cells in the
aars1cq71/cq71mutant brains but decreased markedly upon knocking
out either nfe2l2b or chop (Fig. 6H-J, Fig. S6B). These data indicate
that p53 is a direct target of Nrf2. We then generated a Tg(hsp70:
p53) line in which full-length p53 is driven by the hsp70 promoter
(Wu and Wang, 2020) (Fig. S6C). To facilitate screening, the lens
protein Cryaa-Cerulean-BGHpA element was inserted in reverse
sequence. This allowed us to temporally induce p53 expression at
the desired time points via heating (Wu and Wang, 2020). We
validated the successful overexpression of p53 transcripts based on
the appearance of Cerulean+ signals in the retina and p53+ signals in
the body (Fig. S6D,E). Appearance of AO+ signals in the brains and
significantly decreased midbrain size were observed in heat-
shocked 3 dpf Tg(hsp70:p53) embryos (Fig. S6F,G). In contrast,
transient knockdown of p53 in aars1cq71/cq71 embryos by p53
morpholinos (MOs) markedly attenuated the phenotypes of AO+

Fig. 5. nfe2l2b functions downstream of Perk in aars1cq71/cq71 mutants. (A,B) Representative images (A) and quantification (B) of annexin V+ signals in
HEK293T cells (mean±s.e.m.; DMSO, 2.29±0.64 n=7; Tg, 17.43±3.55 n=7; Tn, 16.44±1.56 n=9; two independent clutches; one-way ANOVA). (C,D) Western
blot of p-PERK (C) and NRF2 (D). The protein levels of p-PERK increased by 298% (P<0.0001) and 253% (P<0.0001) in the Tg and Tn groups, respectively.
The protein levels of NRF2 increased by 210% (P<0.0001) and 67% (P=0.0018) in the Tg and Tn groups, respectively. (E) Immunofluorescent images of
NRF2 (top row) and p-NRF2 (bottom row). (F) Quantification of annexin V+ signals in HEK293T cells (mean±s.e.m.; DMSO, 2.36±0.66 n=7; oltipraz,
22.41±3.38 n=18; two independent clutches; unpaired two-tailed Student’s t-test). (G) Fluorescent images of AO+ signals in the zebrafish midbrains (white
dashed lines). (H,I) Representative images (H) and average fluorescence intensity quantification (I) of NBT-DenNTR (green) and nfe2l2b transcript (red) in
the midbrains (mean±s.e.m.; sibling, 23.92±3.66 n=18; aars1cq71/cq71, 65.86±5.65 n=20; two independent clutches; unpaired two-tailed Student’s t-test).
(J,K) WISH images of nfe2l2b in the brains. (L) Fluorescent images of AO+ signals in the midbrains (white dashed lines). (M) The globe appearance of
5-month-old WT, nfe2l2bΔ1/+ and nfe2l2bΔ1/Δ1 mutant male zebrafish. (N) Immunofluorescent images of TUNEL+ signals in the midbrains (white dashed
lines). (O) Quantification of midbrain size (mean±s.e.m.; sibling, 78,201.27±3053.39 n=12; aars1cq71/cq71, 58,860.49±1452.75 n=13; nfe2l2bΔ1/Δ1,
92,589.72±1977.14 n=12; aars1cq71/cq71 and nfe2l2bΔ1/Δ1, 70,933.32±659.96 n=20; two independent clutches; one-way ANOVA). (P-R) Immunofluorescent
staining images of Sox2 (P), and WISH images of neurod1 (Q) and olig2 (R), in the brains. The arrowheads indicate the signals. (S) Schematic illustration of
Nfe2l2b in regulating NPC apoptosis in aars1cq71/cq71 mutants. Scale bars: 20 µm.
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signals, enlarging the pool of NBT-DenNTR+ cells and midbrain
volume (Fig. 6K, Fig. S6H,I). These p53MO-treated aars1cq71/cq71

embryos survived much longer than their untreated controls
(Fig. 6L); however, no notable nfe2l2b transcript alterations were
observed simultaneously (Fig. 6M), further supporting the epistatic
effect of Nfe2l2b on p53. Similarly, we observed that p53
knockdown significantly decreased cell death in oltipraz-treated
embryos (Fig. 6N). Taken together, these results showed that p53
acts as an executor of Nfe2l2b in the regulation of neuronal survival
and neurogenesis in embryonic zebrafish (Fig. 6O).

Neuronal apoptosis of defective threonyl-tRNA synthetase
via the same Perk–Nrf2 axis
We then investigated whether other aminoacyl-tRNA synthetases
regulated neuronal survival and neurogenesis via the same

Perk–Nrf2 axis. scRNA-seq data revealed the enrichment of
several ARS members in various neuronal subpopulations, in
which tars1 was highly expressed in clusters 4 and 5 (Fig. 7A). We
characterized the phenotype of tars1cq16/cq16 mutants (Cao et al.,
2016). tars1cq16/cq16 mutant embryos presented a notably smaller
head than that of their WT siblings and a curled-up tail (Fig. 7B).
The AO+ and TUNEL+ signals increased dramatically, but the
numbers of NeuN+ (Rbfox3a+) cells and transcript levels of map2
and tuba1b were substantially reduced, in tars1cq16/cq16 mutants
relative to their WT siblings (Fig. 7C-E). These data indicate
increased neuronal apoptosis and failed neurogenesis in
tars1cq16/cq16 mutants. The UPR of ER stress signaling was
initiated in tars1cq16/cq16 mutants, as indicated by elevated
transcript levels of bip and chop and an obvious attenuation of
cell apoptosis upon CHX application (Fig. 7F,G). Similar to in the

Fig. 6. p53 is a direct target of nfe2l2b in neural apoptosis. (A) Schematic of the p53 promoter. Chromatin immunoprecipitation (ChIP)-PCR analysis of
the Nfe2l2b-binding site (green) in the p53 promoter. Blue arrows indicate the ChIP-PCR; gray arrows indicate the ChIP-negative control. Blue rectangle
indicates the selected exon in p53. (B) ChIP-PCR results. IgG, immunoglobulin G; 1F, forward primers; 1R, reverse primers; NF, negative forward primers;
NR, negative reverse primers. (C) Luciferase activities of the plasmids containing different promoter elements (mean±s.e.m.; pCS2, 1.00±0.02 n=6; p53
promoter-BS, 3.69±0.20 n=6; p53 promoter-MBS, 2.08±0.15 n=6; two independent clutches; one-way ANOVA). CDS, coding sequence, EV, pCS2 vector.
(D,E) WISH images of p53 in the brains (D) and embryos (E). The arrows indicate the signals. (F,G) Immunofluorescent images of triple staining of nfe2l2b
(green) and p53 (turquoise) transcripts with NBT:DenNTR (F) or TUNEL (G) after injecting nfe2l2b mRNA. The left images indicate the midbrain regions, and
the white dashed lines highlight the regions of enlarged images on the right. (H) Immunofluorescent images of double staining of NBT:DenNTR (green) and
p53 (red) transcript in the midbrains. The right column contains enlarged images of the boxed region on the left. (I,J) WISH images of p53 in the brains.
(K) Fluorescent images of AO+ signals in the midbrains (white dashed lines). (L) Kaplan–Meier survival analysis (log-rank/Mantel–Cox statistic). (M) WISH
images of nfe2l2b in the brains. (N) Fluorescent images of AO+ signals in the midbrains (white dashed lines). (O) Schematic illustration of p53 as a direct
executor of Nfe2l2b in controlling NPC apoptosis in aars1cq71/cq71 mutants. Scale bars: 20 μm.
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aars1cq71/cq71 mutant, the Perk pathway was selectively activated.
The protein levels of p-eIF2α were increased by 136% in tars1cq16/
cq16 mutants compared with WT siblings (P=0.0009) (Fig. 7H).
However, the splice of xbp1 transcript failed in the tars1cq16/cq16

embryos (Fig. 7I). Concordantly, interfering with Perk functions in
tars1cq16/cq16 embryos by GSK2656157 treatment remarkably
reduced the aggregated AO+ signals (Fig. 7J). Likewise, the
expression levels of nfe2l2b and p53 were increased in
tars1cq16/cq16 mutant brains compared with those in the brains of
their WT siblings (Fig. 7K). Transient interference with the
functions of nfe2l2b or p53 by MO administration significantly
repressed the AO+ and TUNEL+ signals in the tars1cq16/cq16 mutant
midbrain (Fig. 7L,M), implying that tars1 deficiency caused
neuronal apoptosis through a similar Perk–Nrf2 pathway. Taken
together, our study results demonstrated that abrogated protein
metabolism caused by tRNA synthetase deficiency led to
accelerated apoptosis of NPCs and compromised neurogenesis, as
determined by Nrf2 and its target p53. Nrf2 function was doubly
controlled. nfe2l2b transcript was regulated by Chop, with nuclear
activation being promoted by Perk phosphorylation (Fig. 7N).

DISCUSSION
In the present study, we identified a recessive aars1cq71/cq71 mutant
zebrafish allele. aars1cq71/cq71mutant harbored a point mutation that
led to a premature stop codon in the amino acid activation domain
and generated a rapidly decayed truncated Aars1 protein. The
abrogation of Aars1 functions in the present aars1cq71/cq71 null
mutant zebrafish was initially anticipated to cause a failure in protein
synthesis; however, aggregated loads of ubiquitylated proteins and
intensive ER stress were observed in the aars1cq71/cq71 mutant
brains. This result implied that other tRNA synthetases had a
compensatory function, resulting in the production of large amounts
of misfolded proteins. Indeed, the transcripts of nars1, tars1, eprs1,
mars1, yars1, iars1, hars1, kars1, sars1, fars1 and gars1 were
markedly increased in the aars1cq71/cq71mutant brains, based on the
results of scRNA-seq and WISH (Fig. S6J,K).

scRNA-seq analysis revealed intensive enrichment of aars1 in
NPCs, particularly in the primary stages. This different pattern of
aars1 transcription from that of the other members of the ARS
family points to a special and/or unique role of aars1 in harnessing
the signatures of NPCs during embryonic neurogenesis.

Fig. 7. The Perk–Nrf2–P53 axis is similarly utilized in tars1cq16/cq16 mutants as in aars1cq71/cq71 mutants. (A) Violin plot of tars1 expression in nine
neural cell clusters. (B) Brightfield morphological images. (C) Fluorescent images of AO (green) and TUNEL (red) staining in the midbrains (white dashed
lines). (D) Fluorescent images of NeuN (turquoise) in the midbrains (white dashed lines). (E,F) qRT-PCR (mean±s.e.m.; n=6 in each group; two independent
clutches; unpaired two-tailed Student’s t-test) of map2 and tuba1b (E) and bip and chop (F). (G) Quantification of AO+ signals (mean±s.e.m.; control: sibling,
0.13±0.03 n=12; tars1cq16/cq16, 11.72±0.72 n=15; CHX: sibling, 0.20±0.02 n=12; tars1cq16/cq16, 4.32±0.40 n=15; two independent clutches; two-way ANOVA).
(H) Western blot of p-eIF2α and eIF2α. The protein levels of p-eIF2α increased by 136% (P=0.0009) in the tars1cq16/cq16 mutants compared with those in
siblings. (I) xbp1 splicing. Treatment of 24 hpf WT embryos with Tg for 1 h is used as a positive control. S, spliced xbp1. The levels of spliced xbp1 increased
by 359% (P<0.0001) in the Tg group compared with those in the controls. (J) Quantification of AO+ signals (mean±s.e.m.; control: sibling, 0.14±0.03 n=13;
tars1cq16/cq16, 12.67±1.04 n=12; GSK2656157: sibling, 0.38±0.08 n=13; tars1cq16/cq16, 3.65±0.49 n=12; two independent clutches; two-way ANOVA).
(K) WISH images of nfe2l2b and p53 in the brains. (L,M) Quantification of AO+ (L) (mean±s.e.m.; control: sibling, 0.59±0.20 n=13; tars1cq16/cq16, 14.78±0.67
n=13; nfe2l2b morpholino (MO): sibling, 1.78±0.27 n=13; tars1cq16/cq16, 4.72±0.75 n=13; two independent clutches; two-way ANOVA) and TUNEL+ signals
(M) (mean±s.e.m.; control: sibling, 17.79±4.07 n=14; tars1cq16/cq16, 184.50±25.83 n=11; p53 MO: sibling, 3.88±0.89 n=14; tars1cq16/cq16, 27.81±5.62 n=11;
two independent clutches; two-way ANOVA). (N) Schematic diagram of our working model. Scale bars: 1000 μm (B); 20 μm (C,D,K).
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Concordantly, significant apoptosis of NPCs was observed in both
the ENU screening and CRISPR/Cas9-created aars1 mutant
zebrafish alleles, and this phenotype could be rescued by human
AARS1, highlighting the solid and conserved roles of aars1.
Interestingly, scRNA-seq analysis revealed a remarkably enlarged
pool of neuronal progenitors in 2 dpf aars1cq71/cq71 mutant brains
before pronounced cell apoptosis. These data implied the blockage
of differentiation and maintenance of quiescence when progenitors
lacked proper protein supplementation. The maintenance of
progenitor characteristics is controlled by a set of factors, and
Notch activity is a key clue in this situation (Alunni et al., 2013).
Consistently, our sequencing data indicated Notch signaling
activation (Fig. S6L), but the reasons behind its activation upon
compromised aars1 functions were still elusive. Whether and how
Notch signaling is involved in ER stress and neuronal apoptosis
remains an open question.
In the aars1cq71/cq71 and tars1cq16/cq16 mutants, intensive UPR

reactions specifically activated the Perk signaling branch, causing a
dramatic increase in apoptotic cells. PERK activation occurs when
the UPR is beyond tolerance or adaptation, eventually leading to
apoptosis through mitochondrial signaling (Ansari et al., 2018).
QRICH1 was identified as an interesting factor downstream of the
PERK–eIF2 axis as a distinct arm of ATF4 to determine cell fate
through proteostasis modulation (You et al., 2021). However, the
key executive targets of the atf4–chop axis in cell death are unclear.
Taking advantage of this genetic manipulation, we recognized that
nfe2l2b, a paralog of Nfe2l2, is an essential mediator of Perk
signaling that regulates cell apoptosis upon UPR.
In previous studies, NRF2 was found to be a transcriptional factor

that plays a critical role in defense against electrophiles and
oxidative stress (Kawai et al., 2011). However, some reports have
shown that ER stress activates NRF2 activity, whereas others have
opposed these opinions (Chang et al., 2018; Kang et al., 2019).
Interestingly, two paralogs of Nfe2l2 have been found in zebrafish.
The nfe2l2a paralog was closer to Nfe2l2 than nfe2l2b. A recent
zebrafish study demonstrated that nfe2l2a transcript was detected in
the brain and liver, and its activation ameliorated mild ER stress in
the pmm2 mutant liver (Mukaigasa et al., 2018). However, we did
not observe a notable increase in the nfe2l2a paralog in the
aars1cq71/cq71 mutants, and its forced supplementation had limited
effects. In contrast, nfe2l2b appeared in the midbrain, presenting
marked elevation in its transcript level in the aars1cq71/cq71mutants.
Unlike for the nfe2l2a paralog, oversupply of nfe2l2b induced cell
apoptosis. Conversely, interfering with nfe2l2b in aars1cq71/cq71;
nfe2l2Δ1/Δ1 mutants rescued the extensive neuronal apoptosis
induced by ER stress in aars1cq71/cq71 mutants. The distinct effects
of nfe2l2a and nfe2l2b on zebrafish neuronal survival suggest a
diversity of Nrf2 functions in a context-dependent manner. This
alluded to a possible interpretation of the debate regarding the NRF2
response to ER stress. It is a common result that fish harbor duplicated
forms of a plethora of factors. Thus, another possibility is that nfe2l2b
was a unique duplicated factor of Nrf2 acquired by zebrafish during
evolution. However, the pro-apoptotic role of nfe2l2b extends the
understanding of crucial molecules in ER stress.
The target genes of NRF2 in ER stress are limited. A recent study

has documented the interaction of NRF2 with P53 in promoting
cancer cell death (Kang et al., 2019). Our study indicated that p53
was a direct target of Nrf2 and its transcript was significantly
reduced in nfe2l2bΔ1/Δ1 mutants but increased upon overexpression
of nfe2l2b, in which p-NRF2 entered the nucleus to directly increase
the levels of p53 to induce cell apoptosis. These data are in contrast
to a previous report that an increase in p53 level was observed using

nfe2l2b MO (Timme-Laragy et al., 2012). We believe that the
difference was probably caused by the different methods and tissues
used in the two studies. The present study examined the p53
transcripts in nfe2l2b+ cells using both WISH and FISH, in contrast
to the previous bulk qPCR analysis of whole embryos (Timme-
Laragy et al., 2012). Furthermore, this hypothesis supports organ
sensitivity to NRF2. The homozygous nfe2l2bΔ1/Δ1 mutants were
able to survive to adulthood and were comparable to the WT
siblings, suggesting the non-essential role of nfe2l2b in organ
development. However, an obvious reduction in the p53 transcripts
was observed in the nfe2l2bΔ1/Δ1 mutant midbrain. Considering the
wide spectrum of the effects of decreased p53, further studies
should focus on the neuronal phenotypes in the nfe2l2bΔ1/Δ1

mutants, especially in adult animals. Overall, our study extends the
understanding of the regulatory mechanisms of UPR caused by
compromised tRNA synthesis during neurogenesis. Misfolded
proteins have been found to activate Perk signaling, leading to
increased apoptosis of NPCs and termination of neurogenesis via
the Nrf2–p53 axis. Nrf2 is a critical factor in the determination
of cell fate and may be considered a target to attenuate
neurodegenerative disorders with defective tRNA synthesis.

MATERIALS AND METHODS
Zebrafish and cell line
Complete information on the zebrafish (Danio rerio) strains is provided in
Table S2. All experimental protocols were approved by the School of Life
Sciences, Southwest University (Chongqing, China). The methods were
approved by the guidelines. Fish were raised at 28.5°C under a 14 h light/
10 h dark cycle. Embryos were obtained after natural spawning and were put
in E3 buffer with 0.003% 1-phenyl-2-thiourea (PTU; Sigma) to prevent
pigment formation. The zebrafish facility and study were approved by the
Ethics Committee of the College of Life Science, Southwest University. The
HEK293T cell line (see Table S2) was cultured following a standard
protocol. The medium contained high-glucose Dulbecco’s modified Eagle
medium (DMEM) with glutamine and sodium pyruvate (Biological
Industries), 10% fetal bovine serum (Biological Industries), 1%
L-glutamine (Beyotime), 1 µg/ml Mycoplasma Removal Agent Plus
(Beyotime) and 1% Penicillin-Streptomycin-Amphotericin B Solution
(Beyotime). The cells were grown in an incubator (Shanghai Yiheng
Technology) following a standard protocol.

ENU mutagenesis and positional cloning
ENU mutagenesis and positional cloning were performed as previously
described (Trevarrow, 2011). The genetic mapping strain ENU/WIK was
created by crossing heterozygous ENU mutant with WTWIK zebrafish. WT
and mutant embryos were phenotypically collected from pairwise mating of
heterozygous ENU/WIK zebrafish. The Mutcq71/cq71 embryos presented an
obvious reduction of neuronal markers at 2.5-3 dpf. We first located the
mutation to linkage group (LG)18 by bulked segregation analysis, which
indicated a close linkage of the mutant pools with the sequence-length
polymorphism (SSLP) markers in LG18. SSLP markers and SNPs were used
to perform the fine mapping to narrow the genetic interval. The cDNA of
candidate genes was cloned and sequenced from pooled mutants, Finally, a
point mutation in exon 5 of aars1 gene (Ensembl: ENSDARG00000069142)
was identified in Mutcq71/cq71 embryos based on the sequencing data.

Genetic manipulation
aars1Δ10/Δ10 and nfe2l2bΔ1/Δ1mutant alleles were generated by the CRISPR/
Cas9 system (Chang et al., 2013). The gRNAs targeting the 5′-GGGA-
CGGGTCAATGGTGTTCAGG-3′ in aars1 exon 4, and 5′-TGGATG-
TCTCCGGCAGAGGG-3′ in nfe2l2b exon 2, were in vitro synthesized by a
mMESSAGE mMACHINE T7 transcription kit (Thermo Fisher Scientific).
Cas9 protein was mixed with gRNA according to the manufacturer’s
instruction (Biolabs). The mixture was injected into the fertilized embryos at
one-cell stage. The aars1Δ10/Δ10 and nfe2l2bΔ1/Δ1 mutant alleles were
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obtained by DNA sequencing. To construct the pT2AL2-NBT:aars1;cryaa:
cerulean plasmid, the full length of the aars1202 cDNA fragment was
amplified and subcloned into the pT2AL2-NBT;cryaa:cerulean backbone
(Tilton and Tanguay, 2008; Wu et al., 2018). Similarly, to construct
Tg(hsp70:p53) plasmids, specific primers (Table S1) were used to amplify
its cDNA sequence and clone into the pTol2-hsp70 backbone (Wu and
Wang, 2020). To facilitate screening, a Cryaa-Cerulean-BGHpA element
(Hesselson et al., 2009) was inserted reversely. The pT2AL2-NBT:aars1;
cryaa:cerulean constructs (30 ng/μl) containing Tol2 transposase mRNA
(250 ng/μl) were co-injected into the WT embryos at one-cell stage to build
the F0 founders. The stable transgenic lines were recovered in the F1
generation based on the appearance of cerulean+ signals in the eyes and the
same WISH patterns of aars1 as that of NBT. The Tg(hsp70:p53;cryaa:
cerulean) and Tg(NBT:DenNTR) heritable zebrafish transgenic lines were
generated by the same methods.

Heat shock assay
Embryos with Tg(hsp70:p53) transgenic background were heated to 38.5°C
for 40 min and then incubated at 28.5°C. The efficiency of p53 expression
after heat shock was verified by fluorescence signals in the eye and
presentation of p53 by WISH.

Staining assays
RNA probes were synthesized by a DIG RNA Labeling Kit T3/T7/SP6
(Roche). WISH and FISH experiments were performed as described
previously (He et al., 2020; Huang et al., 2019). TUNEL staining was
performed using an In Situ Cell Death Detection Kit and TMR Red Kit
(Roche) following the manufacturer’s instructions or as reported previously
(Lei et al., 2017). AO staining was performed as described (Thompson et al.,
2015). Briefly, zebrafish embryos were incubated with 10 μg/ml AO
solution in the dark at 28.5°C for 40 min. They were then observed by a Carl
Zeiss Discovery V20 microscope. Immunofluorescence staining of
zebrafish embryos was performed following standard protocols (Zhao
et al., 2018). Briefly, embryos of the desired stages were fixed by 4%
paraformaldehyde (4°C, overnight). The embryos were then co-incubated
with the primary antibody (Table S2) at 4°C overnight. Afterwards, the
samples were rinsed with PBDT (phosphate buffer containing 1% DMSO
and 0.02% Tween 20) and then stained with Alexa Fluor 488/555/647-
conjugated secondary antibodies (Table S2). The WISH images
were captured by a Carl Zeiss Discovery V20 microscope. The
immunofluorescence staining images were photographed by LSM700 or
LSM880 confocal microscopes.

Behavioral recording
The behavioral study was performed according to a previous description
(Palmér et al., 2017). Individual zebrafish larvae were placed in a plate
containing 1 ml egg water. To record the movement of spontaneous
swimming behavior, larvae were adaptive for 5 min, and their behaviors
were then captured for 5 min by a scan camera (Basler, model ACA1300-60
GC). Their behaviors after light–dark and needle stimulation were
monitored following reported studies (Marquez-Legorreta et al., 2020;
Sztal et al., 2016). Briefly, to perform the light–dark stimulation experiment,
the larvae were first adapted in a recording box with light for 30 min. Then,
the light was turned off for 5 min and then turned on for another 5 min. The
track of larvae in the 10 min light–dark cycle was monitored by an area scan
camera. To conduct the needle stimulation, a sterilized syringe needle was
used to touch the larval head, and the area scan camera was used to capture
the swimming track for 3 min. All the imaging data were analyzed by the
Ethovision XT15 animal tracking system (Noldus). The distance and
movement speed were calculated accordingly.

Timelapse imaging
Ca2+ activities of neurons were monitored in Tg(HuC:GCaMP6s) embryos.
Embryos were immobilized in 1% low-melting point agarose in a 35 mm
glass-bottom dish. In vivo uninterrupted time-series Ca2+ imaging
experiments were performed with scanning (1.2 Hz at an excitation of
488 nm) under an LSM880 confocal microscope (Carl Zeiss), and the

resolution was 512×512 pixels. The data were extracted by ZEN2012
software, and the movies were created by Corel Video Studio.

Annexin V staining
Annexin V staining was performed following previous instructions (She
et al., 2018). Briefly, Alexa Fluor 488-conjugated Annexin V (Molecular
Probes) was mixed with 1× binding buffer at a ratio of 1:1 (BioVision). The
mixtures were loaded into the midbrain gaps of 3 dpf zebrafish, which were
then incubated in the dark for 1.5 h. Similarly, after HEK293T cells were
treated with 500 μl trypsin solution for 1 min, the cells were collected and
washed twice with pre-cooled PBS. A mixture of 100 μl 1× binding buffer
and 5 μl annexin V-FITC were added to the preparations of 1×106 cells.
These cells were then incubated (37°C) in the dark for 5 min. The signals
were visualized by a LSM700 confocal microscope.

Blastomere cell transplantation
Cell transplantation was performed as previously described (Zou and Wei,
2010). Approximately 30-50 blastomere cells were drawn from 1000-cell
stage WT and aars1 RNP F0 donors with Tg(NBT:DenNTR) background
and loaded into needles. The blastomere cell-filled needles were injected
into the animal pole of 1000-cell stage host embryos (aars1cq71/cq71 or
siblings). The cells were slowly released by a micromanipulator (Eppendorf
CellTram 4r Oil).

Transmission electron microscopy (TEM)
TEM was conducted by Wuhan Servicebio Technology. We prepared the
samples according to their instructions. Briefly, the anaesthetized 3 and
5 dpf zebrafish larvae were placed in pre-cooled 1× PBS, and the midbrains
were microdissected using 0.33 mmmicro-fine sterile needles. The samples
were fixed in the electron microscope fixation solution for 2 h. They were
then moved to 1%OsO4 in 0.1 M phosphate buffer (PB) (pH 7.4) in the dark
at room temperature for 2 h. After removing OsO4, the tissues were rinsed
with 0.1 M PB (pH 7.4) for 15 min, repeated three times. Fixed embryos
were gradually dehydrated with ethanol and embedded individually into
resin blocks. The resin blocks were cut to 60-80 nm thickness by an
ultramicrotome (Leica UC7). The tissues were placed onto 150 mesh
cuprum grids with formvar film, and then stained with 2% uranium acetate
saturated alcohol solution and 2.6% lead citrate. Images were acquired using
a Hitachi HT7800/HT7700 TEM.

Western blotting
Western blotting was performed as described previously (Zhao et al., 2018).
Proteins were purified using cell lysis buffer (Beyotime). Subsequently, the
membranes were blocked in Tris-buffered salinewith 0.5%Tween 20 (TBST)
containing 5% fat-free milk at 37°C for 1 h. The samples were then incubated
with primary antibodies (Table S2), which were diluted by QuickBlock™
buffer (Beyotime) at 4°C overnight. After incubating with corresponding
secondary antibodies (Table S2), the specific bands were detected by an
Odyssey FC two-color infrared laser imaging system (LI-COR).

Vector construction and chemical treatment
The fragments of WT and mutated CDS of aars1were amplified by primers
(Table S1). They were subcloned into a pCS2+ vector to synthesize mRNA
using a mMESSAGEmMACHINE™ SP6 kit (Roche). chop and nfe2l2b
mRNA were prepared by the same method. To perform the ChIP and
luciferase experiments, we used a standard protocol to perform site-directed
mutagenesis (Huang et al., 2019). Briefly, the primers were designed on
both sides of the mutation sites, and 50 μl PCR reactions contained 100 ng
template, 2 μl primer (F/R), 1 μl dNTPs, 1 μl fast-Pfu DNA polymerase and
5 μl reaction buffer. Each amplification cycle consisted of 95°C for 20 s,
50°C for 30 s and 68°C for 10 min. After that, the PCR products were treated
with 1 μl DpnI (15 μl products) at 80°C for 10 min. They were then analyzed
by agarose gel electrophoresis, and finally transformed into Escherichia coli
DH5α by heat shock. The plasmids were isolated by a Miniprep Kit
(Axygen) and then verified by sequencing. To perform chemical treatment,
1.5 dpf zebrafish embryos were incubated with GSK2656157 (65 μM), Tg
(5 μM), Tn (1 μM), CHX (50 μM), oltipraz (10 μM) and Ceapin-A7
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(50 μM). The HEK293T cells at designated time points were cultured with
Tg (0.5 μM or 1 μM), oltipraz (40 μM) and Tn (6 μM) for 24 h.

ChIP and reporter assay
ChIP assay was performed using 24 hpf embryos injected with HA-nfe2l2b
mRNA. Because there was no Nfe2l2b-specific antibody for ChIP assay in
zebrafish, we pulled down the target DNA fragments using antibody against
HA. The eluted DNA (precipitated by anti-HA antibody) was assayed by
PCR. The primers were designed according to the conserved Nfe2l2b-
binding sites (Table S1). Non-specific primers and rabbit purified IgG were
used as controls. The luciferase assays were performed using a Dual-
Luciferase Reporter Assay System (Beyotime). The luciferase activity was
measured by a GloMax 20/20 luminometer (Promega) according to the
manufacturer’s instructions. The −2.6 kb p53 promoter was amplified by
the primers (Table S1) and cloned into a pGL3-basic vector (Promega). The
p53-binding sites were mutated by site-directed mutagenesis using the
designed site-specific oligonucleotide primers (Table S1). HEK293T cells
were cultured in DMEM with 10% fetal bovine serum in 24-well plates.
According to a standard protocol of Lipo8000™ Transfection Reagent
(Beyotime), the plasmids (200 ng pGL3-p53 promoter, 200 ng pGL3-p53
promoter-MBS, 250 ng pCS2-nfe2l2b CDS, 250 ng pCS2 and 40 ng pRL-
CMV) were transfected into cells and cultured for 36 h. Finally, the cells
were harvested to perform luciferase assays using a Dual Luciferase
Reporter Gene Assay Kit (Beyotime).

Phylogenetic analysis, homology analysis and model design
The genomic sequences of nrf2 and aars1 were acquired from the Ensembl
database. The predicted zebrafish Nrf2 amino acid sequence was aligned
with human (Homo sapiens) by the neighbor-joining method. The standard
Kimura two-parameter model was used for the construction of phylogenetic
tree using Molecular Evolution Genetics Analysis software (MEGA,
version 5.1) (Tamura et al., 2011). The divergence was determined by the
distance matrix method. The pairwise distance of Aars1 among zebrafish,
chicken, human and house mouse was estimated (https://www.ebi.ac.uk/
Tools/msa/clustalo/). The model diagram was created in biorender.com.

Quantitative RT-PCR
Quantitative RT-PCR (qRT-PCR) was carried out using total RNA isolated
from the brains of aars1cq71/cq71 or WT siblings according to a previous
method (Wu et al., 2018). NBT-DenNTR+, Sox2-GFP+, Neurod1-EGFP+,
Olig2-DsRed2+ and Coro1a-DsRed+ cells were sorted by fluorescence-
activated cell sorting (Moflo XDP, Beckman). Then, cDNA libraries were
generated by a REPLI-g WTA Single Cell Kit (Qiagen). All data were
obtained by a Roche light cycler 96 machine and the expression levels of
β-actin or ef1α were used as the reference. Table S1 lists information on the
qRT-PCR primers.

scRNA-seq
scRNA-seq was conducted by AccuraMed. The embryonic midbrains
of 2 dpf aars1cq71/cq71 and WT siblings were extracted under a
stereomicroscope by syringes and needles. They were then dissected in
the ice-cold Dulbecco’s phosphate-buffered Saline (DPBS) and dissociated
using a Papain Dissociation Kit (Worthington) according to the
manufacturer’s instruction (Tambalo et al., 2020). Subsequently, the
samples were centrifuged at 200 g for 4 min and washed twice with 1 ml
DPBS. Then, the cells were filtered through a 40 μM cell strainer and finally
resuspended in DPBS. The single-cell suspension was promptly loaded on a
10× Chromium System and sent to AccuraMed. The 10× libraries were
prepared as per the manufacturer’s instructions. The raw sequencing data
were processed by the Cell Ranger software with the default options. The
reads were aligned to zebrafish transcriptome reference (ENSEMBL Zv10,
release 91). The resulting matrices were used as input for the downstream
analysis by Seurat.

Data analysis
The analyses on the UMI count matrix in the two datasets were performed
using the R package Seurat (version 4.0.1) (Butler et al., 2018) following the

standard workflow in the Satija laboratory webpage (https://satijalab.org).
The aars1cq71/cq71 and sibling datasets were merged using the Seurat
function Merge Seurat (https://www.rdocumentation.org/packages/Seurat/
versions/3.1.4/topics/merge.Assay) (Stuart et al., 2019). Initial quality
control was performed by filtering out genes expressed in less than one cell.
Gene selection for dimensional reduction was accomplished using the
Seurat function Find Variable Genes (https://www.rdocumentation.org/
packages/Seurat/versions/2.3.4/topics/FindVariableGenes). Following gene
selection, all log-normalized expression values were scaled and centered
using Scale Data (https://github.com/satijalab/seurat). Principal components
were chosen according to the principal component analysis elbow plot,
which ordered principal components from the highest to the lowest based on
the percentage of variance explained by each principal component. Next, we
performed clustering on each set of principal components and a second
round of dimensional reduction using t-distributed stochastic neighbor
embedding (t-SNE). Markers of each cell type were identified based on their
significant differential gene expression (adjusted P<0.05) using the Seurat
function Find All Markers (https://www.rdocumentation.org/packages/
Seurat/versions/4.1.1/topics/FindAllMarkers). Clusters were annotated
based on the expression datasets of these cluster-specific marker genes on
ZFIN (https://zfin.org). Both datasets contained non-specific cell types that
contained markers for glial (pharyngeal cells), retinal (cone bipolar cells)
and erythrocyte cells were removed after the initial clustering. Following
these stepwise processes, we finally obtained the purified data of each
sample. To identify cell trajectories on pseudotime, the progenitor cells of
Seurat object was converted to Monocle (Durruthy-Durruthy and Heller,
2015).We used the genes of canonical correlation analysis to order Monocle
and defined the maximum component as 2.

GO-term analyses
GO analysis was performed in Database for Annotation, Visualization and
Integrated Discovery (DAVID) (Xue et al., 2019). KEGG pathway analysis
of highly differentially expressed genes was performed on progenitor cell
clusters of aars1cq71/cq71 versus WT siblings by the ‘cluster Profiler’ R
package (Yu et al., 2012).

Statistics of AO signals, midbrain volume and survival ratio
The AO+ signals were quantified as described previously (Sidi et al., 2008).
In brief, the images were analyzed by ImageJ software (National Institutes of
Health, Bethesda, MD, USA). The targeted regions in the midbrains were
outlined by the polygon selector. We reduced the noise using the
‘Image>Adjust> Threshold’ command accordingly (Sidi et al., 2008).
After that, the ‘Analyze>Analyze Particles’ commands were executed, and
the Size (Micro ^2) was set as 1-infinity. The data were obtained by running
‘Display Results, Clear Results’ and ‘Summarize’ programs at the same
time. Finally, the ratio of the marked AO+ area in the whole outlined
midbrain region was calculated using the ‘Area Fraction’ program.Midbrain
area was measured as described previously (Chowdhury et al., 2018). In
brief, zebrafish embryos at the desired stages were anaesthetized by tricaine.
The brains were imaged by a digital camera (Axiocam 506 color, Carl Zeiss)
in a Discovery.V20 microscope (Carl Zeiss). The images were analyzed by
ImageJ software. The ‘Straight’ tool was used to describe the scale. The
‘Analyze>Set Scale’ option was used to calculate the actual size of the
whole image. Then, the ‘Polygon Selection’ tool was applied to determine
the targeted region and the volume was given out by running the
‘Analyze>Measure’ command. To evaluate the zebrafish survival ratio,
embryos in each group were assigned to different tanks and cultured at
28.5°C. The numbers of surviving and dead larval fish were counted daily
from 3 to 10 dpf. The fresh water for larval culture was supplied regularly to
avoid environmental turbidity and hypoxia. Finally, GraphPad Prism 6.01
was used to draw the survival curve, and survival distribution was estimated
by the Kaplan–Meier method.

Gray value and fluorescence intensity measurement
The bands of western blotting and DNA gel electrophoresis were quantified
by ImageJ software. Briefly, the ‘Process>Subtract Background>80’
command was executed to reduce the background. The rectangle tool was
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used to outline the measured bands. The gray values of the bands were given
out by the ‘Analyze>Gels>Select First Lane> Select Last Lane>Plot Plane’
commands. To quantify the FISH fluorescence intensity, the
‘Image>Adjust>Auto Threshold’ instructions were followed. Then, the
‘Analyze>Set Measurements>Area>Mean Gray Value>Limit To
Threshold>Mode Yen’ were selected. The intensity results were
calculated by the ‘Analyze>Measure’ commands.

Quantification and statistical analysis
scRNA-seq statistical analyses were performed in RStudio (version 4.0.3/
4.0.4). The quantified data were double confirmed and analyzed by
GraphPad Prism 6.01. The detailed statistical methods are included in the
corresponding figure legends. Briefly, unpaired two-tailed Student’s t-test
was performed to compare two data groups without any treatment; two-way
ANOVA was employed to weight the two data groups in different
conditions; and one-way ANOVA was performed to analyze the data of
multiple groups. Survival ratio was calculated by Kaplan–Meier
calculations. Error bars indicate s.e.m. All statistical tests, P-values and n
numbers are stated in figure legends
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Fig. S1. Compromised neurogenesis in Mutcq71/cq71 mutants. 

A. The relative expression of sox2, neurogenin1 and map2 in the head of 2.5 dpf siblings and 

Mutcq71/cq71 mutants by qRT-PCR (Mean ± SEM; sox2: sibling, 0.0235 ± 0.0006 n=6, Mutcq71/

cq71, 0.0192 ± 0.0006 n=6; neurogenin1: sibling, 0.0060 ± 0.0001 n=6, Mutcq71/cq71, 0.0047 ± 

0.0002 n=6; map2: sibling, 0.0042 ± 0.0001 n=6, Mutcq71/cq71, 0.0031 ± 0.0001 n=6; two 

independent clutches; unpaired t-test).  

B. The fluorescent images of NBT-DenNTR+ and HuC-GFP+ signals in the corresponding 

reporter larvae.  

C. Bright-field images of the head morphologies. 

D. Kaplan–Meier survival curve (log-rank/Mantel–Cox statistic). 

E-F. The statistical data of overall distance (E) (Mean ± SEM; sibling, 81.74 ± 20.34 n=6; 

Mutcq71/cq71, 3.55 ± 1.22 n=6; two independent clutches; unpaired t-test) and speed (F) 

(Mean ± SEM; sibling, 0.20 ± 0.05 n=6; Mutcq71/cq71, 0.01 ± 0.002 n=6; two independent 

clutches; unpaired t-test) of the spontaneous swimming behaviors.  

Development: doi:10.1242/dev.200342: Supplementary information
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G-I. Representative movement traces after needle touch (G) and the statistical data of overall 

distance (H) (Mean ± SEM; sibling, 40.18 ± 3.97 n=11; Mutcq71/cq71, 7.42 ± 1.68 n=11; two 

independent clutches; unpaired t-test) and speed (I) (Mean ± SEM: sibling, 0.22 ± 0.02 n=11; 

Mutcq71/cq71, 0.041 ± 0.01 n=11; two independent clutches; unpaired t-test) J-L. Representative 

movement traces after light dark stimulation (J) and the statistical data of overall distance (K) 

(Mean ± SEM; sibling, 91.06 ± 14.58 n=11; Mutcq71/cq71, 9.38 ± 

1.39 n=10; two independent clutches; unpaired t-test) and speed (L) (Mean ± SEM; sibling, 0.15 

± 0.02 n=11; Mutcq71/cq71, 0.02 ± 0.002 n=10; two independent clutches; unpaired t-test). 

M-N. The fluorescent images (M) and quantification (N) of PH3+ (green) and TUNEL+ (red) 

signals in the midbrains (Mean ± SEM; sibling, 45.64 ± 2.44 n=11; Mutcq71/cq71, 58.55 ± 3.50 

n=11; two independent clutches; unpaired t-test).  

O. The fluorescent images of AO+ signals in the whole embryos.  

P. The immunofluorescent images of TUNEL in the midbrains (white dash lines). 

Q. The quantification of AO+ signals in the midbrains (Mean ± SEM; 2 dpf: sibling, 0.31 ± 0.10 

n=13, Mutcq71/cq71, 0.26 ± 0.06 n=15; 2.5 dpf: sibling, 1.13 ± 0.09 n=15, Mutcq71/cq71, 15.60 ± 1.25 

n=15; 3 dpf: sibling, 4.52 ± 0.43 n=17, Mutcq71/cq71, 15.10 ± 0.98 n=18; two 

independent clutches; unpaired t-test). 

R. The immunofluorescent images of NBT-DenNTR/TUNEL, GFAP, Sox2/HuC/TUNEL on the 

transverse sections of the spinal cord (white dash lines).  

S. The fluorescent images of AO+ and coro1a-DsRed+ signals in the midbrains (white dash 

lines). The white arrowheads indicate the large AO+ foci aggregated in the coro1a-DsRed+ cells. 

Scale bars in B, M, P, R, S, 20µm; O, 200 µm.  

Development: doi:10.1242/dev.200342: Supplementary information
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Fig. S2. aars1 is evolutionarily conserved in regulating neural survival.

A. Sequencing data of genomic and cDNA of WT, aars1cq71/cq71 and aars1△10/△10 mutant embryos. The 

shaded areas show the mutation sites. 

B. Schematic diagrams of Aars1 protein domains of WT (top), aars1cq71/cq71 (middle) and aars1△10/△10 

mutants (bottom). 

C. Western blot of HA-tagged WT and mutant forms of aars1201 and aars1202. The GAPDH is used as a 

control. The protein levels of HA-aars1201cq71/cq71 and HA-aars1201△10/△10 reduced by 85% (P<0.0001) 

and 95% (P<0.0001), respectively, compared to that in aars1201wt. The protein levels of HA-aars1202cq71/

cq71 and HA-aars1202△10/△10 reduced by 92% (P<0.0001) and 91% (P<0.0001), respectively, compared 

to that in aars1202wt. 

D. The expression of NMD-related gene in the head by qRT-PCR (Mean ± SEM; n=8 in each group; 

two independent clutches; unpaired t-test). 

E. AARS1 homology comparing among zebrafish, chicken, human and house mouse. 

F. The fluorescent images AO+ signals in the midbrains (white dash lines) of siblings and aars1cq71/cq71 

mutants after injecting aars1202wt mRNA. 

G. The immunofluorescent images of TUNEL in the midbrains (white dash lines) of siblings and 

aars1cq71/cq71 mutants after injecting H-AARS1 mRNA. 

Development: doi:10.1242/dev.200342: Supplementary information
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H. Bright-field images of aars1△10/△10 and sibling heads.  

I. WISH of aars1 in the brains of aars1△10/△10 (left), aars1cq71/△10 (right) and their siblings. 

J. Bright-field images of aars1cq71/△10 and sibling heads. 

K. The fluorescent images of AO+ signals in the midbrains (white dash lines). 

L. RNP target loci (A, B, D) of aars1 amplified by the sequencing PCR primers (std, 

standard) or by a headloop primer (HL). Green arrows indicate the ~200-bp ladder band. The 

mutated efficiency: Guide A , 94%; Guide B, 90%; Guide D, 66%.  

M. Western blot of Aars1. The protein levels of Aars1 reduced by 77% in the aars1 F0 

compared to that in the WT control (P=0.0016). 

N-O. WISH of aars1 at different stages. 

P. qRT-PCR of aars1 transcripts in the sox2+, NBT+, HuC+, neurod1+, olig2+ and coro1a+ cells 

(Mean ± SEM; sox2+ 0.048 ± 0.005 n=8; NBT+ 0.096 ± 0.005 n=8; HuC+ 0.059 ± 0.005 

n=8; neurod1+ 0.009 ± 0.0001 n=8; olig2+ 0.009 ± 0.001 n=8; coro1a+ 0.003 ± 0.0001 n=8; 

two independent clutches). 

Q. The immunofluorescent images of Sox2 and NBT:DenNTR in the brains after double 

staining. Scale bars in F, G, K, P, 20 µm. 

Development: doi:10.1242/dev.200342: Supplementary information
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Fig. S3. GO analysis and differential expression of aminoacyl-tRNA synthetases in 

neuronal progenitors. 

A. Schematic workflow of scRNA-seq.  

B. Graph-based clustering of collected cells from siblings and aars1cq71/cq71 mutants. 

C. Violin plots (VLN) showing the transcript intensities of various aminoacyl-transfer RNA (tRNA) 

synthetases in nine neural cell clusters. 

D. GO enrichment analysis of the five most affected signaling pathways in biological 

process, molecular function and cellular component in the aars1cq71/cq71 PCs. 

Development: doi:10.1242/dev.200342: Supplementary information
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Fig. S4. The Perk signaling but not autophagy pathway is activated in 

aars1cq71/cq71 mutants. 

A. The transcript amounts of bip and chop in the head by qRT-PCR (Mean ± SEM; 2.5 dpf: 

sibling bip 0.0611 ± 0.0026 n=6, aars1cq71/cq71 bip 0.1064 ± 0.0089 n=6, sibling chop 

0.0299 ± 0.0013 n=6, aars1cq71/cq71 chop 0.0764 ± 0.0166 n=6; 3 dpf: sibling bip 0.0271 ± 

0.0023 n=6, aars1cq71/cq71 bip 0.0267 ± 0.0065 n=6, chop sibling 0.0149 ± 0.0013 n=6, 

aars1cq71/cq71 chop 0.0676 ± 0.0075 n=6; two independent clutches; unpaired t-test). 

B. Endoplasmic reticulum structure in siblings and aars1cq71/cq71 at 3 dpf by transmission 

electron microscope. N: nucleus; ER: endoplasmic reticulum (red arrows); Mt: 

mitochondria.  

C. The transcript amounts of atf6 and ire1α in the head by qRT-PCR (Mean ± SEM; atf6: 

sibling 0.0069 ± 0.0006 n=6, aars1cq71/cq71 0.0151 ± 0.0013 n=6; ire1α: sibling 0.0009 ± 0.0001 

n=6, aars1cq71/cq71 0.0020 ± 0.0002 n=6; two independent clutches; unpaired t-test). 

D. RT-PCR of xbp-1 splicing in siblings and aars1cq71/cq71. Treating 24 hpf WT embryos with 

Tg for 1 h is used as a positive control. S, spliced xbp-1. The spliced-xbp-1 levels are increased 

by 149% (P<0.0001) in the Tg group relative to the controls.  

E. The fluorescent images of AO+ signals in the midbrains (white dash lines) of siblings and 

aars1cq71/cq71 mutants with or without Ceapin A7 treatment.

Development: doi:10.1242/dev.200342: Supplementary information
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F. Western blotting of p-eIF2α. The p-eIF2α protein levels are reduced by 64% in the 

GSK2656157 group compared to the DMSO control (P=0.0030). 

G. The transcript levels of atf4a in the head by qRT-PCR (Mean ± SEM; sibling, 0.0136 

± 0.0008 n=6; aars1cq71/cq71, 0.0212 ± 0.0013 n=6; two independent clutches; 

unpaired t-test). 

H. RNP target loci (A, B, D) of chop amplified by the sequencing PCR primers 

(std, standard) or by a headloop primer (HL). Green arrows indicate the ~200-bp ladder 

band. The mutated efficiency: Guide A , 88%; Guide B, 89%; Guide D, 71%. 

I. The transcript amounts of chop by qRT-PCR (Mean ± SEM; WT, 0.0016 ± 0.0001 

n=12; chop F0, 0.0004 ± 0.0001 n=12; two independent clutches; unpaired t-test). 

J. The fluorescent images of NBT:DenNTR in the brains of siblings and aars1cq71/

cq71 mutants after injecting chop RNPs. The white arrowheads indicate the NBT-

DenNTR+ signals. 

K. Western blot of Lc3-II/Lc3-I and p62. The β-tubulin is used as a control.  

L. The immunofluorescent staining images of mCherry-LC3 and NBT:DenNTR in 

the brains of siblings and aars1cq71/cq71 mutants. 

M. The immunofluorescent staining images of HuC:GFP and P62 on the 

transverse sections of the midbrains. 

Scale bars in E, H, J, K, 20 µm; B, 0.3 µm. 
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Fig. S5. nfe2l2b, but not nfe2l2a, contributes to the regulation of neural survival in aars1cq71/

cq71 mutants. 

A. Western blot of p-eIF2α and eIF2α in the embryos treating with Oltipraz. The GAPDH is used as 

a control. The protein levels of p-eIF2α and eIF2α are reduced by 32% (P=0.0017) and 22% 

(P=0.0054) in the aars1cq71/cq71 mutants compared to the control. 

B. A phylogenetic tree of the full-length Nrf2 amino acid sequences constructed by the neighbor-

joining method. 

C. WISH of nfe2l2a (top) and nfe2l2b (bottom) at different stages. 

D. The transcript amounts of nfe2l2a and nfe2l2b in the head by qRT-PCR (Mean ± SEM; nfe2l2a: 

sibling 0.0605 ± 0.0035 n=6, aars1cq71/cq71 0.0067 ± 0.0002 n=6; nfe2l2b: sibling 0.0014 ± 0.0001 

n=6, aars1cq71/cq71 0.0033 ± 0.0002 n=6; two independent clutches; unpaired t-test).  

E. WISH of nfe2l2b (left) and nfe2l2a (right) in the embryos after injecting chop mRNA. The 

arrowheads indicate the signals. 
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F-G. The fluorescent images of AO+ (F) and Sox2+ (G) signals in the midbrains (white 

dash lines) after injecting nfe2l2a mRNA. White arrowheads indicate the Sox2+ signals. 

H. Western blot of p-eIF2α and eIF2α in the embryos. The GAPDH is used as a control. 

The p-eIF2α protein levels are reduced by 26% (P=0.2332) in the nfe2l2b mRNA group. I. 

The genomic sequencing of targeted regions in WT and nfe2l2b△1/+ (upper). The shaded 

area highlights the mutation site. Deletion of 1 bp leads to the early termination of 

Nfe2l2b translation in nfe2l2b△1/△1 (bottom).  

J. Western blot of HA. The GAPDH is used as a control. The protein levels of HA-

nfe2l2b△ 
1/△1 are reduced by 96% compared to HA-nfe2l2bwt (P<0.0001).

Scale bar in F, G, 20 μm. 
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Fig. S6.  Over activation of P53 promotes neural apoptosis 

A. Western blot of P53 in 293T cells treating with 0.5 μM or 1 μM Tg. The β-Actin is used 

as a control. The protein levels of P53 are increased by 83% (P=0.0016) and 209% 

(P<0.0001) in the 0.5 μM and 1 μM Tg groups, respectively, compared to that in the 

control.  

B. GSEA enrichment of the up-regulated P53 pathway in cluster 4 of aars1cq71/cq71 

mutants. 

C. The construction of pT2AL-hsp70:p53; cryaa:cerulean vector.  

D. Representative fluorescent images of the lens in Tg(hsp70:p53). 

E. WISH of p53 in WT and Tg(hsp70:p53) embryos after heat shock. 

F. The fluorescent images of AO+ signals in the midbrains (white dash lines) of WT and 

Tg(hsp70:p53) after heat shock. 

G. Quantification of the midbrain size of WT and Tg(hsp70:p53) after heat shock (Mean ± 

SEM; WT, 88845 ± 1656 n=7; Tg(hsp70:p53), 67185 ± 2194 n=7; two independent 

clutches; unpaired t-test). 

H. Quantification of midbrain size (Mean ± SEM; control: sibling, 85374.49 ± 1833.10 n=9, 
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aars1cq71/cq71, 61988.01 ± 1592.02 n=9; p53 MO: sibling, 83299.14 ± 1168.72 n=18, 

aars1cq71/cq71, 74753.43 ± 1586.78 n=12; two independent clutches; two-way ANOVA). 

I. The fluorescent images of NBT:DenNTR in the brains of siblings and aars1cq71/cq71

mutants after injecting p53 MO. The arrowheads indicate the signals. 

J. Heatmap of the up-regulated aminoacyl-transfer RNA (tRNA) synthetase genes in 2 dpf 

aars1cq71/cq71 PCs. 

K. WISH of iars1 in siblings and aars1cq71/cq71 mutants. 

L. KEGG pathway term of the five up-regulated pathways in aars1cq71/cq71 PCs. 

Scale bar in D, F, I, 20 μm. 

Table S1. Primers used 

Click here to download Table S1

Table S2. Key resources 

Click here to download Table S2
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Movie 1. Spontaneous swimming behavior of sibling and Mutcq71/cq71 mutant 

embryos. Related to Figure 1. Five minutes track records of the swimming behaviors 

on 3 dpf embryos after a 5-minute adaptation. The yellow circle area represents the 

imaging field. The red line represents the swimming track. This video presented the 

behavioral recording in Figure 1B. 

Development: doi:10.1242/dev.200342: Supplementary information

D
ev

el
o

pm
en

t •
 S

up
pl

em
en

ta
ry

 in
fo

rm
at

io
n
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Movie 2. The sibling and Mutcq71/cq71 mutant reactions on the light-dark stimulation. 

Related to Figure S1. Ten minutes track records of the swimming behaviors on 5 dpf 

larvae after a 5-minute darkness stimulation. The yellow circle area represents the 

imaging field. The red line represents the swimming track. This video presented the 

behavioral recording in Supplemental 1G. 
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Movie 3. The sibling and Mutcq71/cq71 mutant reactions on the needle-touch 

stimulation. Related to Figure S1. Three minutes track records of the swimming 

behaviors on 5 dpf larvae after a needle touch. The yellow circle area represents the 

imaging field. The red line represents the swimming track. This video presented the 

behavioral recording in Supplemental 1J. 
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Movie 4. Spontaneous Ca2+ activity in the midbrains of sibling and Mutcq71/cq71 

mutant embryos. Related to Figure 1. Simultaneous calcium imaging of neuronal cells 

in 3dpf midbrains of Tg(HuC:GCaMP6S) embryos. Acquisitions were performed with 

scanning at 1.2 Hz at an excitation of 488 nm. The resolution was designed by 512 x 512 

pixels on Tg(HuC:GCaMP6s). And the time-length of single-layer imaging was 252 

seconds in total, with 200 cycles. The selected fame images were given in Figure 1C. 
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